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Welcome to CCH® ProSystem fx® Engagement and CCH® ProSystem fx® Knowledge Coach v2018.2.3

This bulletin provides important information about the v2018.2.3 release of CCH ProSystem fx Engagement and CCH ProSystem fx
Knowledge Coach. Please review this bulletin carefully. If you have any questions, additional information is available on CCH Support

Online.

Note: There are two guides that provide important information relating to the installation and deployment of Engagement v2018.2.3.
These are the Installation Guide and the Deployment Planning Guide found in the Documents folder with the Install Media.
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How to Deploy - For IT Administrators and Third-Party IT Providers

1. Close CCH ProSystem fx Engagement before running the installation files.
2. Close all Microsoft® Office applications, such as Word, Excel® and Outlook®.
3. Download the installation file using Software Delivery Manager.
4. Install the SQL instance.
— Notes:

- The SQL instance is not required for a Terminal Server Client installation. Click to see steps for installing to a Terminal
or Citrix server.

. SQL 2016 and SQL 2017 installations should be run locally rather than from the network.

5. Install CCH ProSystem fx Engagement.

— Note: You can confirm the Workpaper Management, Trial Balance, TGUW and Knowledge Coach version numbers by
reviewing the following registry key:
<computer>\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\ProFXENGAGEMENT30\Common

For further information see "How do | install CCH ProSystem fx Engagement?" on CCH Support Online.

Technologies No Longer Supported with 2018 Releases

The following technologies are no longer supported:
e Microsoft® SQL Server® 2008 and 2008 R2
e Citrix® XenApp® v6.x

e Internet Explorer® 10

Technologies Supported with 2018 Releases

The following new technologies are now supported:
e Microsoft® Office 2019
e Microsoft® Windows® 10 Fall Creators Edition
e Microsoft® SQL Server® 2017 (available in 64-bit only)
e QuickBooks® 2018
e Citrix® XenApp® v7.15
e Citrix® XenApp® v7.16

At Wolters Kluwer, we want to ensure that we are staying current with the latest technologies. Therefore, going forward, we will
support only the current and one prior version of both third-party technologies and our CCH applications. The latest system
requirements can be found on the Engagement Support site CCH Support Online.



https://support.cch.com/kb/solution.aspx/sw15275
https://support.cch.com/kb/solution.aspx/sw15275
https://support.cch.com/kb/solution.aspx/sw33791
https://support.cch.com/productsupport/productSupport.aspx?id=10

New in this 2018.2.3 Release - CCH ProSystem fx Engagement

2018 Tax Grouping List Template Update
The following 2018 tax grouping list templates (.AZG files) were updated as detailed in the Knowledge Base article here.

e 2018 C-Corp - ProSystem fx Tax

e 2018 S-Corp - ProSystem fx Tax

. 2018 Exempt Org - ProSystem fx Tax
e 2018 S-Corp - Lacerte

e 2018 S-Corp - UltraTax

Important: The updated templates are applicable only when creating 2018 tax grouping lists by importing from the Account
Groupings - Grouping List Options dialog. The update has no effect on 2018 tax grouping lists created by running the Tax Grouping
Update Wizard.

Provided in a Prior 2018 Release - CCH ProSystem fx Engagement

2018 Tax Grouping Update
The 2018 Tax Grouping Update includes the changes as detailed in https://support.cch.com/kb/solution/000094697

CCH® ProSystem fx® Tax and CCH Axcess™ Tax

¢ The Tax Grouping Update Wizard will update tax grouping lists to 2018 tax codes.

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership, Exempt and Individual tax entity types.
Lacerte®

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership and Exempt tax entity types.
GoSystem® Tax

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership and Exempt tax entity types.
UltraTax CS®

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership, Exempt and Individual tax entity types.

New Trial Balance Diagnostic
A Source TB Changes trial balance diagnostic is provided to notify preparers and reviewers when changes have been made to the source
trial balance since the last time data was imported to the target trial balance via Import from Engagement TB.

Pfx Engagement API Integration Kit
An APl integration kit, including documentation, is provided to expose the following Engagement v2018 data:

e C(lients, staff and teams: Retrieve client, staff and team data. Add and/or update client and staff data.
e  Staff groups and licenses: Retrieve staff group data and retrieve the total and/or remaining count of purchased product licenses.

e Binders: Retrieve, add and/or update binder data including adding binders based on a binder template; assigning and unassigning
staff; assigning and unassigning teams.

e Workpapers: Retrieve a list of workpapers in a binder. Add workpapers to a binder.
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Pfx Trial Balance API Integration Kit
An APl integration kit, including documentation, is provided to expose the following Engagement trial balance v.2018 data:

e Account type, account class, and ratio class: Retrieve account type, account class, and ratio class data for a given trial balance.
e Fund type, subtype, and fund: Retrieve fund type, fund subtype, and fund data for a given trial balance.

e Grouping list, group, and subgroup: Retrieve grouping list, group, and subgroup data for a given trial balance.

e Account: Retrieve detail account data for a given trial balance.

Using Engagement Organizer

Engagement Organizer (EO) is a new cloud-based feature for your client request lists (Prepared by Client (PBC) documents). It provides an
automated way to request, send, and receive documents from clients before beginning an engagement. You and your clients can attach a
file of any type, including a ZIP file, to a request list item. Engagement Organizer allows for easier tracking of the documents received and
outstanding. It also provides notifications when changes are made or when outstanding requests are approaching their due date.

Your firm’s existing PBC documents that are formatted to meet the specifications for an EO request list and can be saved as a CSV file, may
be uploaded to replace a request list in Engagement Organizer. For more information, refer to the Replace Request List topic in the CCH
ProSystem fx Engagement Help or User Guide.

Engagement Organizer is now available to any Engagement customer also using CCH Client Axcess™ Portal. Don’t have CCH Client Axcess
Portal? Reach out to your Regional Solution Consultant to learn more. Want to learn how to use it? See the Engagement Organizer topic in
the CCH ProSystem fx Engagement Help or User Guide.

Important: If your firm is licensed for CCH Client Axcess™ Document where Portal is integrated (versus stand-alone Portal), at least one
client must be set up in CCH Axcess Client Manager before using Engagement Organizer. In the Client Profile dialog, select the Portal
navigation item. In the Portal management options, select the Enable portal check box. Fill in the remainder of the Portal management
options. The Portal administrator will receive an email where he/she must log in and set up a password.

CCH® Audit Accelerator Enhancements
The CCH Audit Accelerator link in the Engagement Tools menu is updated to launch a new version of the application for firms with Audit
Accelerator licenses. The following enhancements are provided in the new version:

e Data uploads from accounting packages are faster to provide a better client experience.

e  Ability to schedule uploads which eliminates the need for multiple requests to the client and supports a continuous audit.
e Streamlined and enhanced user interface.

e  Significantly enhanced admin functionality, including reporting.

Option for Up to Four Reviewers

To improve workpaper review workflow, a new Number of reviewer sign offs option is provided in the Tools > Firm Options > Sign Off tab in
the Engagement Administrator module. The number of reviewer sign offs can be set as two, three, or four. In the Workpaper Management
module, when signing off a workpaper, the available levels of reviewer sign offs is based on the Firm Options setting. The following features
reflect the selected number of reviewers:

e Workpaper Properties - Sign Off.

e Workpapers menu, right-click menu and toolbar in the binder.
e  Reviewer columns in the Binder View and Current Editor View.
e Reviewer columns in the central file room view of the binder.

e Nodes in the tree control of the Sign Off Summary View.



e  Binder Snapshot - Sign Off Status.

e Binder Index and Sign Off Summary Report.
e Workpaper Sign Off History Report.

e  Binder Portfolio.

Drag and Drop a File to Replace a Placeholder or Manual Workpaper

In both the local file room copy of a binder or the central file room view of a binder, a placeholder or manual workpaper can now be
replaced by dragging and dropping a file to the tab where the placeholder and/or manual workpaper resides. After dropping the file, when
the index and workpaper name are set to be the same as the placeholder or manual workpaper (and Overwrite is selected for Local File
Room (LFR) binder), the replacement occurs without having to subsequently delete the original placeholder or manual workpaper from the
Trash.

Trial Balance Diagnostics

Preparers and reviewers now have a more efficient workflow when analyzing the status of trial balances (TB) in the binder. A Diagnostics
icon displays in the Diagnostic column of the binder, and the Diagnostics Pane displays listing the following diagnostics for a TB selected in
the binder:

e Re-consolidation Needed
o Displays when any subsidiary TB update affects the consolidated TB.
o Diagnostic is cleared when the consolidated TB is re-consolidated.
e Out of Balance
o Displays when a current period balance column included in any view of the TB does not sum to zero.
o Diagnostic is cleared when updates are made to the TB resulting in the balance column summing to zero.

Spell Check Trial Balance and Journal Entry Reports

The Microsoft® Excel® Spelling feature is not available in TB and JE reports created in Engagement v7.5 or later releases. It is also
recommended that the Microsoft® Spelling feature not be used for reports created in releases prior to 7.5 because it might resultin a
corrupt report. A new Spelling icon is now provided on the Engagement ribbon so that reports can be spell checked without the concern of
report corruption.

Launch Excel® as Full Screen Option
A new Launch Excel® as full screen option is now provided in the Tools > Options dialog. This allows each Engagement user to optionally
display all Excel® workpapers opened from the binder as full screen.

Provided in a Prior 2018 Release - CCH ProSystem fx Engagement Administrator

Number of Reviewer Sign Offs in Firm Options
Administrators can now increase the number of reviewer sign offs from two reviewers to either three or four reviewers. The new Number
of reviewer sign offs can be set to two, three, or four in the Tools > Firm Options > Sign Off tab.

Ability to Unarchive Binders Located on a Different Server
Binders that were archived on a different server can now be unarchived by allowing an administrator to navigate and select the archived
binder file that is located on the other server.

e Example: The ability to unarchive binders that were archived prior to a server migration is now provided.



Provided in a Prior 2018 Release - Updated and New Utilities

Updated Backup and Restore Utility

When restoring either a full or differential backup, the administrator must select whether to authenticate using their Microsoft® Windows®
User Account or by entering their SQL login credentials. The utility must be "Run as administrator" when Windows® Authentication is
selected unless a domain account is created for the Windows® user in the SQL instance.

Updated Delete Binders Utility
Filters applied in the Delete Binders Utility are updated such that all binders selected for deletion in the list of filtered binders delete as
expected. You can now hold down either the SHIFT or CTRL key to select multiple binders in the list.

Updated Admin Views Utility
The following views in the Admin View Utility now provide a Bulk Edit feature.

The Binder Teams view provides a Bulk Edit option to Assign team(s) or Unassign team(s) to/from a group of selected binders.

e  Example: If the *All Firm Staff* team is assigned to multiple binders and your firm no longer wants that team assigned, the binders
can be selected and the *All Firm Staff* team can then be unassigned by clicking Yes in the warning message that displays.

The Binder Staff view provides a Bulk Edit option to Assign staff or Unassign staff to/from a group of selected binders.

e Example: If a new staff member needs to be assigned to all Audit type binders, those binders can be selected, and the staff member
assigned quickly and easily.

The Licenses by Staff view provides a Bulk Edit option to Assign licenses or Unassign licenses to/from a group of staff.

e  Example: This is especially useful if your firm purchases a new CCH ProSystem fx Knowledge Coach title and the license for that title
needs to be assigned to many staff members.

New App Checker Utility

A new utility is available to assist with diagnosing and addressing issues where Engagement pre- requisites are not set correctly on the
system. The utility will repair issues with third-party applications such as Excel®, Word, and Adobe?®. It will also assist with diagnosing
problems with ports as well as services not running. The appcheckerui.exe can be found in the Utilities folder on the local workstation at
C:\Pfx Engagement\WM\JUtilities.

Provided in a Prior 2018 Release - CCH ProSystem fx Knowledge Coach

Keep Custom Program Steps in the Program Step Library

When your firm creates custom steps for industries or specific customers, these custom steps can now be stored in the program step library
without having to keep them displayed in the audit workpaper even when you update to a new version of the title. On the Workpaper
Properties settings, select the Knowledge Coach Roll Forward tab. Under Data Retention Options, the option to Keep custom program
steps is now independent of the option to Keep audit programs populated with program steps in Engagement v2018.

Get Knowledge Coach Template Updates

This new option allows teams to pull template updates into their active binders. Users can get AUD- 80X series program steps including
custom program steps and CCH steps added to the audit program. Template updates also include changes to roll forward settings for
workpapers in binders created from the template.

Get the Latest Correspondence, Report, Resource, or Microsoft® Excel® Knowledge Coach Workpapers Directly from the Web
Beginning with the KBA Commercial 2018 title, these workpapers will be created and inserted directly into the binder using the CCH®
Accounting Research Manager® (ARM) content. There will be no changes to the way that you insert, update, or use these files. However,
when applicable standard updates or industry changes occur after the title has been released, you can get the latest version of these files
without having to install a Knowledge Coach Content Update or getting them from Accounting Research Manager (ARM). Instead, you can
get the updated version delivered directly into your binders by using the Tools > Repair Knowledge Coach Workpaper option or by
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inserting a new version of the workpaper through the New Knowledge Coach Workpaper dialog. An internet connection will be required
when you insert the file into your binder, update content, or open the workpaper for the first time.

View CCH Program Steps that can be Addressed Using TeamMate Analytics

A new TeamMate Analytics icon will display in the program step library of the AUD-80X workpapers to show which program steps can be
accomplished using this data analytics tool. Expand the program step in the library to show all the sub-steps and then hover over the icon
to see the applicable TeamMate Analytics test name.

Note: Icons will display on the main steps as a notification that sub-steps have applicable TeamMate Analytics tests. In these instances,
there will not be hover text in the main step. The TeamMate test name will also display at the end of the program step in the workpaper so
that you can review the test name without having the program step library open.

Install KBA Commercial 2018 on Engagement v2017

A separate Knowledge Coach Update will be available with the Commercial 2018 title that will allow you to install the 2018 Commercial title
on your 2017 Engagement version so that your Knowledge Coach users can begin using this title and all titles that require the 2018 Financial
Statement and Compliance Base titles before your firm updates all computers to Engagement v2018.1.3.

Issues Resolved in a Prior 2018 Release

Issues identified in a previous release of Engagement or Knowledge Coach have been resolved to enhance your workflow, including:

e QOut of Memory error no longer occurs when editing binder properties in the Administrator module and more than 500,000 binders
exist in the central admin.

e The title bar displays the proper index and name when opening Adobe® Acrobat® and Reader DC workpapers.

*  You are no longer prompted to enter your password when inserting Microsoft® Outlook® emails or attachments in a binder when
you are already logged into Engagement.

e Microsoft® Excel® message dialogs now display in the forefront when an Excel® workbook is opened after another Excel® workbook
is already open.

e  Custom user groups are now able to modify roll forward settings in Knowledge Coach workpapers when this right has been assigned
to the group.

¢ The Repair Knowledge Coach workpapers feature is no longer available for Knowledge Coach Microsoft® Excel® workpapers
because this feature is only applicable for Knowledge Coach Microsoft® Word workpapers that contain Knowledge Coach tables.

¢ The file modified date updates correctly for Knowledge Coach Microsoft® Word workpapers immediately after changes are made so
that the modified after reviewed icon displays as expected in the Binder window.

e Synchronization improvements for Knowledge Coach workpapers are included to prevent missing sign-offs after binder
synchronization.

Important Notes

Engagement and Knowledge Coach Versions Supported in 2018
Beginning with this release, we will no longer support Engagement versions prior to v7.5.

To ensure the highest quality support and product experience, CCH will only offer support for the current version and one previous year's
version of the software. For this purpose, “support” is defined in two parts: Technical Compatibility and Customer Support.

MSSQLSPROFXENGAGEMENT instance now utilizes BUILTIN\Administrators login



The MSSQLSPROFXENGAGEMENT instance now utilizes BUILTIN\Administrators login to execute install, modify, and repair actions. It is also
used when performing database restore actions. Do not remove the SQL login for BUILTIN\Administrators after deploying the application.

SA login for MSSQLSPROFXENGAGEMENT is now disabled after installation

The SA login for MSSQLSPROFXENGAGEMENT is now disabled after installation is complete on all environments. Firms currently using SA
login to access the instance must configure a unique SQL login for this purpose or use Windows® Authentication to access the
MSSQLSPROFXENGAGEMENT instance. SA login should remain disabled on each system.

SQL Admin Login (sa) Now Supports Complex Password Policies

Previously the SQL admin login failed to use a complex password. This resulted in SQL installation failures when firm level security policies
were not properly met. The new password has better support for more complex requirements. Please refer to the Engagement Knowledge
Base article 66404 for further information about the SQL Admin login changes.

Tax Grouping Update Wizard

You can no longer run the Tax Grouping Update Utility from a machine with only the Administrator module installed. You must run the Tax
Grouping Update Wizard from a machine that has either the Workpaper Management module installed, Administrator and Workpaper
Management modules installed, or Terminal Services Client installed.

CCH® ProSystem fx® Practice Advantage
The Practice Advantage integration is removed.

Knowledge Coach Base Titles

Most Title Packages for Knowledge Coach v2018.2.3 require a related Base Title to be installed before the Title Content Package can be
used. The Base Title is a package that contains data that is common to various titles. This provides the ability to decrease the size of each
title and allows fixes to be made in one package rather than multiple title packages. Information on which Base Title is needed can be found
on the Knowledge Coach Updates site when the title is downloaded. The Base Title does not have to be released to everyone to use the
Content Title.

Installation Information
Please refer to the Installation Guide and the Deployment Planning Guide for important information relating to the installation and
deployment of Engagement. These guides may be found in the Documents folder with the Install Media.

.NET 4.6.1 Full Required for All Installation Options
The installation requires .NET 4.6.1 Full for WM, TSClient, TSDatabase, Admin, and AdminWS installations.

Service Packs
It is strongly recommended that the latest service packs for operating systems and other software are installed for Engagement to run
optimally. Please refer to the Installation Guide for more details on the recommended and required versions.

Upgrade Operating System or Microsoft® Office
If applicable, complete operating system or Microsoft® Office upgrades prior to installing the latest version of Engagement.

Refer to the Installation Guide for detailed information regarding the installation and configuration of Engagement.

Upgrade Engagement

Upgrades to Engagement v2018.2.3 are supported from Engagement v7.5 and v2017. It is required that all Engagement office servers and
workstations be upgraded. If you are currently using a version prior to 7.5 and require assistance with upgrading, please contact Technical
Support.

When upgrading the Engagement Administrator module from v7.5 or higher, you will be required to reset your name and password after
the installation of v2018.2.3, if you have changed the logon account for the PFXSYNPFT Service to allow workpapers to reside on a remote
server. Failure to do so will result in failed synchronizations.

During a new installation of Engagement Administrator module, the creation of bin databases for storing binder information will default to
the installation directory (x:\Pfx Engagement\Admin\Data). If you prefer the bin to be created in a location other than the Admin
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installation directory, you must change the bin directory path on the Choose Bin Database Path dialog during the installation. Please refer
to the Installation Guide for additional information.

For specific user rights requirements please refer to Appendix in the User Guide.

Ports
Engagement transfers data over the following ports:

e SQL Server (PROFXENGAGEMENT) - TCP port 2029; UDP port 1434
e Pfx.Engagement.SocketService - TCP port 4531

e PFXSYNPFTService - TCP port 6735

e  PFXEngDesktopService - TCP port 6736

e  PfxConfigUtility - UDP port 6737

e  P2EWinService - TCP ports 943 and 4530

e  SharedFileRoom - TCP port 445

e  KCShared Service - TCP port 8731

These ports are configured on the server and workstations during installation. However, if you are connecting over a VPN, through a
firewall, or another device such as a router, you will need to ensure that these ports are opened for the program to work correctly.

Mass Deployment

Engagement allows for mass deployment/installation by way of pushing the install to computers. Installs using an MSl file vary depending
on what deployment tool is used. For instructions on how to complete the installation with an MSI package using Active Directory®, please
refer to the Installation Guide. If you are using a deployment tool other than Active Directory®, please consult your deployment application
documentation for further instructions on how to push the install with an MSI package.

Minimum Requirements

The minimum system memory for Engagement Administrator or Workpaper Management modules on a 32-bit computer is 2 GB. In
addition, Engagement requires MDAC 2.8 SP1 or higher on each workstation. For more information on the system requirements, refer to
CCH Support Online.

Logging in After Update
After the upgrade from a previous version, there is a VSTO clean-up process that will add time to the initial log in to Engagement. It may be
helpful to notify end users of the additional initial login time.

SQL Express/SQL Upgrade

SQL Server® Express is a free edition of SQL Server® that may be used in conjunction with Engagement. If firms choose to purchase
Microsoft® SQL Server® 2012, Microsoft® SQL Server® 2014, Microsoft® SQL Server® 2016 or Microsoft® SQL Server® 2017, there may be
additional licensing costs associated. Please refer to Microsoft® SQL Server® versions for detailed licensing options.

Important: Engagement v2018.2.3 supports Microsoft® SQL Server® Express, Standard and Enterprise editions in versions 2012, 2014, 2016,
and 2017 as its database engine.

Operating Systems Not Supported
Engagement should not be installed on the following:

e Microsoft® Small Business Server (for more information, see http://support.cch.com/kb/solution.aspx/sw34431).

e A Domain Controller Server (for more information, see http://support.cch.com/kb/solution.aspx/sw3787).



https://support.cch.com/productsupport/productSupport.aspx?id=10
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e An Exchange Server

e Linux®, as it is supported for workpaper storage only.

Conversion of Binders, Templates, Packages and Trial Balance Databases

Binders
When upgrading, the Engagement binder databases will be converted during the installation process.

Important: Prior to installation, ensure there is a successful backup of the Engagement databases, workpapers, and templates. For
additional information, please refer to Appendix A: Database Backup and Restore in the Admininistrator Guide.

Templates and Binder Packages

All binder templates must be converted from the Workpaper Management module after installing Engagement v2018.2.3. Binder templates
created in v4.0 or later may be converted directly to v2018.2.3. Binder template conversion must be run on a machine with a local
installation of Engagement Workpaper Management. Users in a Citrix® or Terminal Services environment should convert the binder
templates in a non-Citrix® or non-Terminal Services environment. The binder templates can then be copied to the Citrix® or Terminal
Server.

Trial balance templates created in Engagement v4.0 or higher can be converted via a process provided on the File menu of the Engagement
File Room.

Binder packages created in Engagement v4.0 or higher will automatically be converted to v2018.2.3 when received into a local file room.
Binders archived in v4.0 or higher may be unarchived with v2018.2.3. Binder backups created in Engagement v4.0 or higher can be restored
into v2018.2.3.

Database Backup & Restore

Regular nightly backups of Engagement databases, workpapers, and templates will enable you to restore them in the event of a hardware
failure or other disaster. In addition, you can choose to incorporate differential backups as part of your backup strategy. If you require
assistance in setting up a scheduled nightly backup or ensuring your current backup is capturing all necessary files, please visit
http://support.cch.com/kb/solution.aspx/sw33890 or contact Technical Support.

During the installation of the Engagement Administrator module v2018.2.3, the Database Backup & Restore Utility will automatically be
installed to the x:\Pfx Engagement\Admin\Utilities\Backup Restore directory.

Important: If you are currently using third-party backup software to back up the Engagement databases, you will not be able to restore a
single binder to the central file room. The CCH® ProSystem fx® Engagement Database Backup & Restore Utility allows the restoration of a
single binder or an entire central file room.

For additional information about the Database Backup & Restore Utility or instructions on setting up a scheduled task for the nightly
backup, please refer to Appendix A: Database Backup & Restore in the Administrator Guide.

Other Information

Microsoft® Windows® 7 and Windows® 8.1

When running the CCH® ProSystem fx® Engagement Configuration Utility in a Windows® 7 or Windows® 8.1 environment with User
Account Control (UAC) enabled, the Interactive Services Detection service must be running. The recommended best practice is to configure
the Interactive Services Detection service to start automatically.
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Virtualization included in Microsoft® Windows® 7 or Windows® 8.1 limits users' rights to certain directories with User Account Control
(UAC) enabled. Due to these limitations, it is recommended that Engagement not be installed to the C:\Windows, C:\Windows\System 32,
or C:\Program Files directories. For additional information, refer to

Microsoft's Windows Vista Application Development Requirements for User Account Control Compatibility document. Please contact
Technical Support for installations of Engagement v7.5 or higher that currently exist in these locations.

Microsoft® Office 2013 Ribbon

The Engagement menu items will appear on both the Engagement Ribbon and on the Add-Ins tab. It is possible to disable the Engagement
Ribbon functions by going to the Excel®/Word Options, and choosing Add-Ins. Select Manage COM Add-ins and uncheck
Pfx.Ribbon.ExcelAddIn (for Excel®) or Pfx.Ribbon.WordAddiIn (for Word) from the list of Add-Ins available.

Microsoft® Office 365™

Microsoft® offers multiple packaging options (called “plans”) for Office 365™, which are either available with online only versions of the
Office applications or desktop versions. (For example, Office 365™ Midsize Business or Office 365™ Enterprise E3.) To use Office 365™ with
Engagement, you must subscribe to a version of Office 365™ that includes a desktop version and have the desktop version of Office
installed on the PCs that will be running Engagement. In this scenario, the experience is essentially the same as the running Microsoft®
Office 2013.

Note: CCH does not currently have plans to support online only versions of Office. This is since Microsoft® does not support customized
ribbons/add-ons in the online versions.

Go here for a comparison of the different Microsoft® Office 365™ plans, and which ones include desktop versions of the applications.

Office Servers/Administrator Module
Changing the computer name after Engagement is installed is not supported. Changing the computer name may cause login failures,
synchronization failures, and database errors.

System time clocks must be synchronized across all office servers to ensure proper data flow between servers. Failure to properly ensure
that all time clocks are synchronized before performing Administrator module functions may result in data loss.

Static IP addresses are recommended for all office servers.
All office servers should be synchronized before adding a new office server or updating to a new version of Engagement.
All Administrator users must have access and rights to the Admin Share directory on all office servers.

Export to Tax
Dynalink from Engagement to CCH® Global fx® Tax through a Citrix® session is not supported.

Dynalink to both Global fx Tax and the desktop application for a single client is not supported.

When using the Dynalink option to export trial balance data to CCH® ProSystem fx® Tax or CCH Axcess™ Tax, the Employer ID # (EIN) used
for the Dynalink configuration on the Tax Software Interface dialog in Engagement must be unique. If you have multiple clients that will be
using the same EIN, please add additional characters to the end of the EIN to make each one unique (e.g., 99-999999-1).

Synchronization
Synchronization utilizes two services for data transfer. The services are PEXSYNPFTService.exe and PfxEngDesktopService.exe. For further
information regarding these services and how they function, please refer to Appendix in the User Guide.

Shared File Room
Editing Knowledge Coach workpapers and the Add/Remove Tax Grouping utility are not supported for use with Shared File Room.

General
Engagement toolbar customizations may be made using a 1024x768 or greater screen resolution. Lower screen resolutions may result in
the inability to view additional toolbar buttons added to the Engagement toolbar.
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Large fonts are not supported by Engagement.

CCH Software News Delivers Valuable Product Information via Email

CCH Software News expedites important CCH ProSystem fx product information to your firm via email. Technical bulletins, tax, technical
discussions and product update notifications are forwarded directly to your individual and/or firm’s email address, ensuring that you are
kept abreast of pertinent issues which affect your CCH ProSystem fx products.

If you provided an email address with your order, you are already registered for CCH Software News and will receive information on the
products your firm is currently licensed for in the near future. We encourage you to visit our Web site at CCH Support Online and click on
CCH Software News Profile Setup to establish or modify your firm’s CCH Software News profile to ensure you are receiving information on
all the CCH ProSystem fx products you desire.
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